FB-MULTIPIER
Example Problem 1-12

January 2016

Jae H. Chung, Ph.D.
Anand Patil, P.E.
Michael Davidson, Ph.D., P.E.
FB-MULTIPLIER EXAMPLE PROBLEMS

The following examples were developed to acquaint the user with both the input and output of FB-MultiPier. Due to the large number of options which are available for input and output, the examples will concentrate on typical input (pile cross-sections, soil, loading, etc.) and general output. The examples are arranged in no order of difficulty, but in type of problem being solved. It’s recommended that the user work all the problems, since different features are used.

1. LATERALLY LOADED SINGLE PILE

Consider the laterally loaded single pile shown in Figure 1.1. The pile is Florida Department of Transportation's standard 0.76 m (30") prestressed concrete pile which is embedded in a soft clay overlying a medium dense sand.

When FB-MultiPier is run by double clicking the mouse on the FB-MultiPier icon, the user will first see a blank screen with a pile cap in the center as shown in Figure 1.2. To create a new model, select New as shown in Figure 1.3.
Although Single Pile is one of the problem types, this example will start with a Pile and Cap Only problem to model the single pile in order to demonstrate more of the program features. Choose Pile with Cap only, SI units and enter the general information shown in Figure 1.4.
It should be noted that it is on this screen (Figure 1.4) that the user selects the type of problem that they are going to solve (i.e. general pier, pile with cap, sign, etc.) and the units that they are going to be working in.

After clicking OK at bottom of dialog, the default data set is loaded, as shown in Figure 1.5. Figure 1.5 is the general-purpose input, which is split into 4 separate screens. The Model Data window (top left) is referred to as the tab dialogs. These dialogs control all soil, geometry, loads, analysis and problem types input. Note that the font in the tabbed dialog depends on the screen resolution. To change the font go to the Control menu and choose Set Dialog Font and select a suitable viewing font for the tabbed dialog. The Pile Edit window (top right) is the plan view of the piles, cap and coordinate system. By right clicking the mouse in this window, the user can delete, batter, and change the spacing of the piles. The bottom left window is the Soil Edit window. This window shows the elevation of all soil layers, water table, pile top and tip elevations, and general soil information. Right clicking the mouse in this window will also allow the users to insert, delete, and split layers. The bottom right window is the 3D View of the piles, cap and structure, if there is one. Right clicking the mouse in this window allows
the user to view the structure in thin element mode, and rotate the structure with the mouse (3D rotate).

The latter is useful for placing loads, springs, etc. on different nodes of the structure.

To model the example problem, the number of piles has to be reduced from 4 to 1 and the pile cap has to be removed. This is accomplished by clicking the Pile & Cap tab dialog in Model Data window (Figure 1.6a). To begin specify no cap overhang by going to the Control menu and unselecting ‘Apply Overhang’ which will disable the Overhang option under Pile Cap. Next, under Cap Data, click the Edit Pile Cap button and change the cap Thickness to 0 as shown in Figure 1.6b. Click OK to apply the change in pile cap thickness. At this point the Pile & Cap tab in the Model Data window should look like Figure 1.7.
Figure 1.6a Pile and Cap Tab Initial Appearance

Figure 1.6b Change Cap Thickness to Zero
To remove three piles (to create a single pile model), change the number of X and Y grid points to 1. Each change will prompt a warning that the Pile Geometry has changed and may affect some Soil properties. Click OK each time and the new pile configuration will be shown as in Figure 1.8. Note the number of piles in the Pile Edit (top right) and 3D View (bottom right) windows is now one.
Figure 1.8 Change Grid Points to 1 by 1

It should be noted at this point that the pile data can be obtained by left clicking on the pile in the Pile Edit window. Doing so now shows the dialog box with the top x and y coordinates and the x and y batter. For this problem, confirm that both the x and y coordinates are set to 0 as shown in Figure 1.9. This pile information can be viewed at any time during the pile modeling by clicking on the pile of interest in the Pile Edit window.

Figure 1.9 Pile Data Dialog Box
The pile type and pile length should now be changed while the Pile & Cap tab dialog in the Model Data window is still visible. In the Pile & Cap tab dialog, move the mouse to the Pile/Shaft Type option (that currently has 0.455 M Square FDOT) and click the drop down list. A drop down list with H-pile/Pipe Pile, Precast, Circular, and Multiple will appear. Moving the mouse over any of these shows a sub list of piles, shafts, etc., which are presently in the database that the user may select from. The user may add to this database when they edit their pile/shaft. From the Precast menu select the 0.76 M Square FDOT Standard prestressed. This pile with dimensions, steel, properties, etc. replaces the default 0.455 M square FDOT standard. Then change the length of the pile by clicking the Edit Cross Section button to bring up the Full Cross-Section Pile Properties dialog. Any of the pile or shaft dimensions, properties or material properties can be changed from this dialog. Change the Length property to 19m as shown in Figure 1.10a. The final Pile tab dialog should appear as in Figure 1.10b. This finishes the pile layout and properties input.

![Figure 1.10a Change Pile Length](image-url)
The soil stratigraphy and properties will now be changed along with the water table. This is accomplished by selecting the Soil tab from the Model Data window. Generally this screen is referred to as the Soil tab dialog. It allows the user to input soil layers, their properties, as well as view soil resistance (i.e. P-Y, T-Z, etc. plots). All information in the tab dialog refers to the soil layer selected in the Soil Layer Data box. A black box is drawn around that layer in the Soil Edit window that is being edited.

Since Example 1 has two soil layers (similar to the default set), only layer elevations, soil types and properties need to be changed for the default data. The Soil Type combo box (under Soil Layer Data) is presently displaying Cohesionless. Click the drop down button and select the Cohesive soil type. Note that Soil Layer information regarding Lateral, Axial and Torsional properties goes blank and the Tip property is greyed out as shown in Figure 1.11. The user needs to select a model for each (drop down arrow alongside) first. The necessary soil properties can then be entered using the Edit button after specifying all four soil models.
FB-MultiPier highlights in the active soil layer model name in blue. Click the mouse on the drop down button under soil layer models "lateral" as shown in Figure 1.12 and select Clay (Soft < Water) for the Layer 1.

These five different options represent the same p-y models in FHWA’s COM624 with the addition of O’Neill’s model used by API, as well as a user defined (Custom) p-y data set for a clay.
Before the user may edit the data for lateral model, a selection must be inputted for the other soil-pile interaction models. Under axial (Figure 1.13), the user has the option of selecting Driven Pile, Drilled Shaft, and Custom T-Z. Note it's assumed that the axial behavior of driven piles and drilled shafts are different from one another vs. the lateral model, which assumes that they are interchangeable. Also, all model selection is based on soil layer number and soil type, which must be selected first. For this model, select Driven Pile.

![Figure 1.13 Axial Soil Model](image)

In the case of the Torsional model, there are only two to choose from (Hyperbolic or Custom). Select the Hyperbolic, which requires the initial slope and ultimate skin friction (see Chapter 4). In the case of the pile/shaft tip model in Figure 1.14, the user may select from driven pile, and multiple drilled shaft options. Note that the tip model selection is greyed out because the pile tip is in Layer 2.
Once all the soil-pile models have been selected, look at the Soil Edit window (bottom left) and observe that soil layer 1 has changed colors to brown (brown: cohesive; yellow: cohesionless; rock: gray) as shown in Figure 1.15.

Figure 1.14 Select Torsional Soil Model

Figure 1.15 Soil Layer 1 Changed to Cohesive with Undrained Strength
Next, the elevations of the first soil layer, as well as the water table need to be changed. For soil layer 1, enter 0 m for the top elevation, -3 m for the bottom and 0 m for the water table as shown in Figure 1.16.

![Figure 1.16 Change Elevations of Layer 1](image)

At this point, the user can edit the soil parameters for each of the Soil Layer Models for Layer 1. Click on the Lateral drop down list to activate the lateral soil properties. (The word “Lateral” should now be blue). Now click the Edit button to edit the lateral soil. Enter the values shown in Figure 1.17 and click OK.

The user has the option of viewing the p-y, t-z, etc. for the top or bottom of each layer. For instance, the soft clay's p-y curve for the bottom of the layer 1 is shown in Figure 1.18. The latter was obtained by clicking the Plot button in the Soil tab dialog. Click OK when done. This concludes the data entry for the top soil layer for this example.
Figure 1.17 Additional Soil Properties Dialog Box (Layer 1)

Figure 1.18 P-y Plot for Soil Layer 1
Next click on Soil Layer 2, in the Soil Layer box so that the soil properties can be specified for the second soil layer. Select the Soil Type as Cohesionless. Confirm that the Lateral soil model is Sand (Reese), the Axial model is Driven Pile, the Torsional model is Hyperbolic, and the Tip model is Driven pile. Click on the Lateral model drop down list to activate the lateral properties. Click the Edit button and enter the values shown in Figure 1.19. When done change the elevations of top of layer to -3 m, and the bottom of the layer at -20 m (below the pile tip) and water table elevation for the layer at 0 m. The Soil Edit window should appear as shown in Figure 1.20.

![Figure 1.19 Additional Soil Properties Dialog Box (Layer 2)]
To change any information within a given soil layer, the user may click on Soil layer in the soil tab dialog, or left click on that layer with the mouse in the soil edit window. Try left clicking with the mouse on the Layer 1 (cohesive) in the soil edit window (bottom left). Notice that the black border now encompasses layer 1.

The only other information required to analyze Example 1 is the pile loads, which are accessible from the Load tab dialog in the Model Data window. Since the default data set has two load cases, the user needs to left click the mouse on load case 2 and delete this load case with the left Del button.

The node in the 3D View that presently has a load on it is Node 1, which is leftover from the original pile and cap only problem. Click on Node 1 in the list and delete this load by clicking the right Del button. To add a load to Node 1, left click the mouse on the top node in the 3D View window. Click Add and then enter 150 kN for the lateral load (X) in the tab dialog and press the tab or enter key to update the load. The Load tab dialog should now look like Figure 1.21.

The “Self Weight” list item is used to enter load factors for self weight and buoyancy. Although self weight will not be included in this problem, for simplicity, in a general problem the user would click on Self Weight and enter the appropriate load factors for each load case. Leave the factors as zero.
For Example 1, all of the data has been input (Soil, pile, and loading). The screen should now look like Figure 1.22.
Now the single pile problem can be analyzed. Shown in Figure 1.23 are the toolbar buttons which are available to perform separate tasks (i.e. input, analysis, pile results, structural results, etc.). For instance, the general four split screen input that has been used to this point is available by pushing the Edit Model button.

![Figure 1.23 Input, Analysis, and Result Viewing Toolbar Buttons](image)

Clicking the mouse on the Run Analysis button will generate the popup window shown in Figure 1.24 after being prompted to save work and overwrite the results. The window identifies what is occurring in the analysis, i.e. current load step, out of balance forces, moments, etc. The analysis can be stopped at any point using the Stop Analysis button in the top right corner. After a successful run, the window will identify that the forces in the system were recovered and then the status window will display Done. The window will close automatically if the analysis converged to a solution.

![Figure 1.24 FB-MultiPier Performing Analysis of Example 1](image)

At this point, there are a number of different viewing options available (pile resultant forces, displacements etc.) with the viewing icons given in Figure 1.23. For viewing pile displacements, click on the “3D Results” button and Figure 1.25 is generated. The user may find the displacements of any point
on the pile by clicking the mouse on the node of interest on the undeformed pile. The node should turn orange, and the displacements and rotations will be displayed in the 3D Display Control window to the left.

![Figure 1.25 3D View of Pile Displacements](image)

For viewing the pile resultant forces, moments, and pile-soil reaction along the pile click the Pile Results button in the toolbar. In this view, the resultant forces are plotted along the pile length. The user controls what graphs to plot in the lower bottom window by clicking the forces/displacements of interest on or off in the Plot Display Control window. Since, this is a single pile analysis only one pile is visible in the Pile Selection window; however, if this was a group with a number of piles, the user could click on piles of interest. Their results would be displayed together in the lower result windows. Click on the pile in the Pile Selection window to activate the pile. Check Shear 2, Moment 3, Demand/Capacity Ratio, Soil Axial, and Soil Lat X in the Plot Display Control window. Next, check Apply to plot the forces along the length of the pile. The resulting view is shown in Figure 1.26.
Figure 1.26 Pile Resultant Forces, Moments, etc. Along Pile Length

The last window displayed in Figure 1.26 is the Demand/Capacity Ratio along the pile. It identifies the ratio of the resultant moments from equilibrium divided by the biaxial moment capacity for the section at that depth. For this problem, the value is 0.289, indicating that the section under the given loading is at about 30% of its ultimate load capacity.

To see the resultant moments in both directions vs. the actual moment capacities for a pile click the Pile Interaction button in the toolbar and select Biaxial Moment Interaction. Figure 1.27 shows the typical biaxial interaction diagram. The user can click on different pile elements along the pile to view the interaction. The symbols I and J refer to the bottom and top of the element, respectively. For the top element that is currently selected, the combination of bending moments is clearly inside the failure surface. Uniaxial Moment Interaction diagrams can also be viewed for bending about the local 2 and 3 axis. For the uniaxial moment interaction diagrams, the axial load is plotted against the bending moment.
Figure 1.27 Resultant Moments and Segment Capacities

The user may print any active window by clicking on the printer icon (see Figure 1.23). The full output is saved to a file "<filename>.out", where the <filename> is the name of input file that you saved. To view this output file from the graphical interface, click on the Control menu and select View Analysis Data.

COMPARISON OF FB-MULTIPLIER RESULTS TO OTHER PILE ANALYSIS PROGRAMS

The Single Pile Example shown in Figure 1.1 was recreated using LPILE (Ensoft) and COM624P (FHWA) for comparison to the FB-MultiPier results. This discussion shows that the results are very similar results between the COM624P and FB-MultiPier analyses. The results differed somewhat between LPILE and FB-MultiPier, though. The results from all three programs were extracted from their respective output files and plotted for comparison in the discussion that follows.
Before proceeding it is important to explain a significant difference between the interpretation of the pile diameter between FB-MultiPier and the LPILE and COM624P programs. FB-MultiPier uses an effective soil diameter for non-circular piles, which considers both cross-sectional dimensions of the pile. This procedure was implemented to be consistent with the diameter used in the calculation of vertical skin friction on non-circular piles. (For square piles, the effective soil diameters is about 13% larger than the pile width) In contrast, LPILE and COM624P use only the width of the pile in determining the soil reaction. Note that for round piles, the pile diameter is the same for all three programs. The results presented below use a round pile implementation for FB-MultiPier so that a valid comparison can be done between the programs.

![Figure 1.28 Comparison of Soil Reaction.](image)

**Figure 1.28** shows some variation in the soil reaction computed by all three programs. The variation in soil reaction can be attributed to the difference in the p-y curve methodology used by each program. While all three programs compute an equivalent depth of soil layers by matching the ultimate soil resistance at the soil layer interface (Georgiadis 1983), the procedures are clearly not identical. The FB-MultiPier results fall in between the COM624P and LPILE results. Notice that the discrepancy occurs at approximately 3 meters along the pile, at the interface between the soil layers.
As shown in Figures 3.1.29 and 3.1.30, the values of the maximum shear and moment are similar for FB-MultiPier and COM624P. The results are slightly different when compared to LPILE.

![Figure 1.29 Comparison of Pile Shear Force.](image1)

![Figure 1.30 Comparison of Pile Moment.](image2)

For the pile deflection plotted in Figure 1.31, the FB-MultiPier and COM624P results match very well. LPILE predicted a smaller pile deflection though.
A comparison can also be made for the error in equilibrium along the pile. Consider a free body diagram of the top portion of the pile. This diagram would include the loads at the pile head and the soil reaction force results all the way up to the cut. The error in shear equilibrium can be determined by summing the horizontal forces and then solving for the shear force at the cut. This shear force can then be compared to the shear force reported by the program at the cut. The difference between the values can be attributed to numerical error in the solution process.
The following graph shows the difference between the pile shear forces reported by LPILE, COM624, and FB-MultiPier compared to the shear force obtained from the respective horizontal force summations. The results show that there is significantly less numerical error in determining the shear force using FB-MultiPier. Although not shown here, there is also a similar numerical error associated with the determination of moment equilibrium in the pile. The end result is that you can expect to see a different location for the maximum shear and moment along the pile when comparing the results of the three programs, particularly when dealing with layer soil systems.

It should also be stated that all three programs satisfy global equilibrium. In all cases, the externally applied load equals the sum of the soil reactions. The distribution of that load along the pile between the three programs can be notably different, however.

This concludes Example 1.
2. **BRIDGE GENERAL PIER**

Shown in Figure 2.1 is the bridge pier with geometry and soil conditions, which will be modeled in Example 2. The problem represents a navigable waterway crossing, which involves both lateral and axial loads. The foundation consists of 6-54 inch drilled shafts (80 ft long), and two pier columns which are 30 ft tall, 5 ft square and spaced 16 ft apart. The pier cap is 4 ft thick and the drilled shaft cap is 10 ft thick with a 4.5 ft overhang. Due to scour, the sand surface is located 15 ft below mean sea level, and the soft rock is characterized as FHWA's intermediate geomaterial. The properties of the sand and rock are given in Figure 2.1.

![Figure 2.1 Example 2, Pier Structure](image)

From the File option, the user needs to select new (Figure 2.2):
Choose General Pier and enter the general information in **Figure 2.3**. Be sure to choose the English systems of units to load the correct default data set.

**Figure 2.3 Select General Pier, English Units and Enter Project Description**
After clicking OK at bottom of dialog, the default data set is loaded. **Figure 2.4** shows the general-purpose input, which is split into 4 separate screens. The top left is referred to as the Model Data window. The Model Data window contains tabbed dialogs that control all soil, geometry, loads, analysis and problem types input. The top right is the plan view of the piles, cap and coordinate system. By right clicking the mouse in this window, the user can delete, batter, and change the spacing of the piles. The bottom left window is the Soil Edit window. This window shows the elevation of all soil layers, water table, pile top and tip elevations, and general soil information. Right clicking the mouse in this window will also allow the users to insert, delete, and split layers. The bottom right window is the 3D View of the piles, cap and structure, if there is one. Right clicking the mouse in this window allows the user to view the structure in line mode, and rotate the structure with the mouse (3D rotate). The latter is useful for placing loads, springs, etc. on different nodes in the structure.

**Figure 2.4 Default Data Set (3x3 Pile Group)**

To model the example problem, click the Pile & Cap tab in the Model Data window. To begin, click on the yellow drop down box to access the Pile/Shaft Database and select 54” drilled shaft from
Drilled Shaft list and confirm the change in grid spacing. Change the number of grid points in the Y-direction to 4. Now the number of piles has to be reduced from 9 (from a 3x3 group) to 6 (to a 3x2 group). Next, in the Pile Cap Data section, set the Overhang to 54 inches. Finally, confirm that the pile spacing in both the X and Y directions is set to 3d. The Model Data window should now look like Figure 2.5a.

![Figure 2.5a Pile Tab Dialog Adjusted for Number of Piles and 54” Drilled Shaft](image)

The next step is to edit the pile cap properties. To do this, click on Edit Pile Cap in the Cap Data section. The Cap Properties dialog should appear as shown in Figure 2.5b. Enter the values shown below and then click OK to apply the parameters and exit the dialog.

![Figure 2.5b Pile Cap Properties](image)
The four split screen inputs should look like Figure 2.6. Note the Pile Edit window (top right) shows six shafts (i.e. 3x2).

![Figure 2.6 General Input Screen for Shafts with Pile Cap](image)

After completing the shaft and cap configuration, the user is ready to specify the soil stratigraphy, properties, and the water table. To begin, click on the Soil tab with the Model Data window (Figure 2.7). This problem consists of two soil layers below a water table. Confirm that a Cohesionless soil is selected for Layer 1 to model the top sand layer. Change the Unit Weight to 120 pcf. Change the Axial soil model to Drilled Shaft Sand. The other soil properties can remain as their default values. Next, change the Elevation of the Water Table to 0 ft, the Top of Layer 1 to -15 ft, and the Bottom of Layer 1 to -50 ft. Make sure to include the negative signs on the elevations to indicate a downward direction. Notice that while editing the soil properties, a black box appears around the current soil layer.
The second soil layer properties can now be entered after completing the soil properties for the first soil layer. For this problem, the second layer consists of soft rock with the properties given in Figure 2.1. To begin editing the second layer, select Add Layer from the Soil Layer drop down list (Figure 2.8). Click OK in the dialog to confirm the layer addition. Notice that a black box is drawn around the second soil layer, indicating that soil layer 2 is the current soil layer.
To create the soft rock layer for layer 2, select Rock from the Soil Type list as shown in Figure 2.9a. After selecting the rock Soil Type, proceed to the Soil Layer Models. For the Lateral model, select Clay (Soft < Water) from the drop down list. For the Axial model choose Drilled Shaft IGM and for the Torsional model choose Hyperbolic. Finally, for the Tip model, choose Drilled Shaft IGM. After selecting the Soil Layer Models, change the Unit Weight of the rock to 140 pcf. Also change the Water Table Elevation to 0 ft, the Top of Layer 2 to -50 ft, and the Bottom of Layer 2 to -80 ft. Again remember to include the negative signs in the layer elevations. All of the rock layer parameters are shown in Figure 2.9a.

Before completing the rock layer, the soil properties must be specified for the Clay (Soft < Water) Lateral Model. To do this, first click on the Lateral model label to activate the layer model. At this point the word “Lateral” should be blue. Now, click the Edit button next to the Soil Layer Models. Enter the properties shown in Figure 2.9b and click Ok when done.
Now the soil properties must be specified for the Axial Soil Model. To do this, first click on the Axial Model to activate the layer model. At this point the word “Axial” should be blue. Now, click the Edit button next to the Soil Layer Models. Enter the properties shown in Figure 2.9c. For this problem change the the Mass Modulus to 20 ksi and the Modulus Ratio to 0.5, the (socket) Surface to ‘1’ for Rough, Split Tensile Strength to 40,320 psf, the Unit Weight Pile Concrete to 150 pcf, and the Slump to 6 inches. All other properties in this dialog can remain as their default values. Click OK when done.
The final plot of the soil strata should look like Figure 2.10. Note that you can zoom in or out of this soil layer view by clicking the center mouse button (if available) to toggle to 3D control mode. After doing so, hold the Control key down while left clicking the mouse and dragging the mouse upward or downward.
The pile system is now complete and is embedded into the given soil layers. The next step is to change the pier structure to model the current pier. To begin, click on the Pier tab in the Model Data window. Enter the values that appear in Figure 2.11 to modify the pier structure. These are the same dimensions given in Figure 2.1 in the introduction to Example 2. Also, be sure to click the Full Cross Section button so that a complete cross section can be specified for the pier. The pier should appear centered on the pile cap in the 3D in the bottom right window. Remember that at any time you can click the right mouse button in the 3D window to change the viewing properties of the pier system.

Figure 2.11 Selecting the Structure Tab for Structure Properties

The Full Cross Section button was clicked to enable the section properties for the pier. Click the Edit Cross Section button to view the dialog shown in Figure 2.12. This dialog allows the user to specify the dimensions of the pier component, the stress/strain curves, and the placement of the reinforcing steel. The list under Pier Component shows the sections that are currently defined. By default there are two sections, representing the pier column and the pier cap beam. To modify the column section, click the first item on the list to activate the column section. Click the Customize Current Section to change the section properties. Now change the Width and Depth of the column to 60 inches. Note that the name of
the cross-section is called “Custom” until the section is saved to the database. This can be done after entering all of the properties for the section. Now click on the Edit Properties button to specify the material properties for the column. At this time, only the concrete properties can be entered. The steel properties will be entered after specifying the layout of the reinforcing bars. Enter the concrete properties shown in Figure 2.13 and click OK when done.

Figure 2.12 Default Pier Cross-Sectional Properties
Figure 2.13 Default Stress/Strain Curves

The next step is to customize the shape of the cross-section. Return to the Pier Component Properties dialog if not already there. Start with the Pier Column first by clicking on the Column component in the list. Again, the name of the section name “Custom” will be changed after entering all of the section properties and saving the section to the database. Make sure that the Rectangular Section shape button is activated. Then click on the Edit Section Contents button to specify the reinforcement. The Rectangular Section Properties dialog should appear as shown in Figure 2.14.
First, create a new bar group by clicking the Add button under Edit Bar Groups. The list now shows “Group1” as the only group. To place the reinforcement, the user must select the number of bars in each row, the bar area, the starting coordinates of the row, and the orientation of the row (either horizontal or vertical). For this problem, use 12 #11 bars with a bar area of 1.56 in$^2$. The origin of the bar placement is in the center of the square shown in Figure 2.14. To maintain a 4” concrete cover with the 60” x 60” column, the bar placement should start at the point (-26, -26) to place a vertical row (Parallel to 3 Axis) of bars on the left face of the column. Enter these values as shown in Figure 2.14a and click Apply to update the bar group. The first row of bars now appears.
Figure 2.14a First Row of Reinforcing Steel

Now a horizontal row of reinforcing steel can be added. Click Add to create “Group2”. Enter 10 #11 bars with a bar area of 1.56 in$^2$. Change the starting bar coordinates to (-21.27, 26) in the 2 and 3 directions, respectively. This starting coordinate will ensure that the bar spacing is consistent both vertically and horizontally. Make sure to click “Parallel to 2 Axis” for a row of steel. Enter the values shown in Figure 2.14b and click the Apply button when done to update the bar placement. Enter the 3rd and 4th bar groups in a similar manner. Make sure to change the starting coordinates to (26, 26) for group 3 and (21.27, -26) for group 4. When finished, click Apply and the bar placement should look like Figure 2.14c. Click OK when done to return to the Element Properties dialog.
Figure 2.14b Second Row of Reinforcing Steel

Figure 2.14c Final Placement of Reinforcing Steel
Before saving the section, the material properties for the reinforcing steel should be entered. To do this, make sure that the column section is selected from the list material property. Click Edit Properties to enter the steel properties. In the dialog, click Mild Steel to activate the steel properties and enter the values given in Figure 2.15. Click OK when done to return to the Element Properties dialog.

![Figure 2.15 Entering Steel Material Properties](image)

In order to change the name of the column section click ‘Add To Database’ to add the section to the existing database. Change the name of the section to “Linear 60”x60” concrete”. When finished the dialog should look like Figure 2.16. Click OK. The Material Property list will update after clicking Retrieve Section in the Pier Component Properties dialog. After selecting the section just created, the Pier Component Properties dialog will look like Figure 2.17.
The pier cap section can then be specified now that the column section is complete. For this example, the pier cap will be reinforced in a similar way to the pier columns. Assume that the pier cap is
4ft (48 inches) deep and 5 ft (60 inches) wide. Also assume that the cantilever portions of the pier cap are not tapered. To start with the Pier Cap properties, click Modify Current Section and then change the Width to 60 inches and the Depth to 48 inches. Next, under Material Properties change the f’c Compressive to 5 ksi and the Concrete Modulus to 4200 ksi by editing the stress/strain properties and clicking OK. Now click Edit Section Contents to enter the data for the reinforcement.

The placement of the reinforcing bars is based on a system of local axes that is different than the column. This is because the orientation of the pier cap section is different than the pier column section. The difference in the local coordinate systems is shown in **Figure 2.18**.

![Figure 2.18 Local Coordinate System for Pier Column and Pier Cap](image_url)

The bar layout in the Section Properties dialog is based on the appropriate 2-3 coordinate system. For both the pier column and pier cap, strong axis bending is assumed about the 3-axis. For the pier cap, the 2-3 axes are oriented differently than the column 2-3 axes. Therefore the reinforcement will be placed differently in the Section Properties dialog. The following steel placement will illustrate the proper use of the 2-3 local coordinate system.
Create a new bar group by clicking Add. Then create a vertical row of 6 #9 bars with a bar area of 1 in$^2$. Start a row parallel to 2 Axis at (-16, -26) for the 2 and 3 directions, respectively. After entering the values and clicking Apply, the dialog should look like Figure 2.19a. Create a second bar group for the row of vertical bars at the right. Click the Add button and use the same bar properties, but start the row at (-16, 26) for the 2 and 3 directions, respectively.

![Rectangular Section Properties dialog](image)

**Figure 2.19a First Row of Steel Bars for Pier Cap Beam**

The horizontal layers of steel (for flexure) can be created in a similar manner. Use 12 #11 bars with a bar area of 1.56 in$^2$ on both the top and bottom. Add two rows parallel to 3 axis as Group 3 starting at the point (-21, 26) and Group 4 starting at the point (21, 26). The final bar placement should appear as in Figure 2.19b. When finished click OK to return to the Pier Component Properties dialog.
Before leaving the Pier Component Properties dialog, click the Edit Properties button to specify the stress-strain values for the mild steel in the pier cap section. Click Mild Steel and enter 60 ksi for the Yield Stress and 29,000 for the Modulus. Click OK when done to update the cross-section.
Click OK to return to the main program.

Now that the pier configuration is complete, the 3D View looks like Figure 2.21a.
To change the view, click the right mouse button in the 3-D view window. The menu that appears (**Figure 2.21b**) allows you to change the various plotting characteristics of the pier. To rotate the pier to a new orientation, select 3D Mouse Control. Hold the left mouse button down and move the mouse in the direction that you wish to rotate the pier.

![Figure 2.21b 3-D View Menu](image)

Click on the Load tab in the Model Data window to apply the loads to the pier. First, delete Load Case 2 using the “Del” button to the left of the Load Case list. Next, delete the nodal loads in Load Case 1 one at a time using the right “Del” button (the Self Weight item cannot be deleted). The lateral load will be included first by clicking on Node 38 in the 3D View window and then clicking the Add button (to the right of the node list). Node 38 is a node on the center left side of the pile cap where the lateral load will be applied. Enter 1000 kips for the X Load. The dialog should look like **Figure 2.22**.
The node can also be activated by clicking on the appropriate node in the 3D view of the pier. To demonstrate this, click on the leftmost node of the pier cap. The node turns orange and the Load dialog shows that the node is Node 71. Click Add to add the node to the load case and enter 150 kips for the Z Load. Notice that the load arrow turned orange to indicate the current load. Next, add 250 kips to Node 70 and 85 (Z Load at the top of the two pier columns). Finally add 150 kips to Node 89 at the right end of the pier cap. When all of the loads are entered, the load dialog should look like Figure 2.23.

For this example, leave the Self Weight and Buoyancy Factors as zero to ignore self weight.
For the last part, a spring will be added to simulate the lateral stiffness of the bridge. To accomplish this, click on the Springs tab in the Model Data window. Now in the 3D View of the pier click on the far right node in the pier cap to place the spring there. Click on Add to create a new spring. Enter 5000 kips/in for the Stiffness in the X Direction for Node 89. The dialog should now look like Figure 2.24. The spring should visible in the 3D View at this point.

![Figure 2.23 Final Load Application](image)

![Figure 2.24 Lateral Spring Application](image)
The analysis options should now be set before analyzing the pier. Click on the Analysis tab in the Model Data window. Since this is a preliminary analysis, select Linear for both the Pile Behavior and the Pier Behavior. Later, these can be switched to nonlinear for a complete analysis including nonlinear material behavior and p-Δ effects. The dialog should look like Figure 2.25.

The data entry phase is now complete. Save the file if you haven’t already done so by clicking on the disk icon at the top of the screen. Type “Example2.in” for the name of the file. The pier is now ready for the analysis phase.

![Figure 2.25 Analysis Options]

To analyze the pier, click on the button at the top of the screen. A dialog appears showing the status of the analysis after prompting the user to overwrite the file. The time needed for the analysis will depend on the speed of the computer. When the analysis is done the window will close automatically.

To view the drilled shaft (or pile) results, click on the button in the top toolbar. Click
on the drilled shaft labeled ‘1’ in the Pile Edit window and then click Apply in the Plot Display Control window. The screen should now look like Figure 2.26, which shows different plots for drilled shaft #1.

As an example, look at the plot of moment about the 3 axis along the pile. Click on the Moment 3 window to signal the Plot Display Control Window to update the maximum and minimum moment values. Notice that for shaft #1, the largest moment is -1,409.3 kip-ft.

The plots for other shafts can be generated at the same time by clicking on the shaft number and then Apply. To remove a shaft from the plots, click on the shaft in the Pile Edit window to return the shaft to its original color and click Apply. Use the check boxes to control the number of plots shown. Remember to click Apply to redraw the plots. The maximum force values can also be plotted for all load cases.

![Figure 2.26 Drilled Shaft Results](image)

To view the pier structure results, click on the button in the top toolbar. Click on the pier cap in the Structure window and then click Apply in the Plot Display Control window. The screen should now look like Figure 2.27, which shows different plots for pier cap. The plots for the pier columns can
be generated at the same time by clicking on the pier component and then Apply. Use the check boxes to control the number of plots shown. Remember to click Apply to redraw the plots. The maximum force values can also be plotted for all load cases.

Figure 2.27 Pier Structure Results

To view the interaction diagrams for the drilled shafts (or piles), click on the button in the top toolbar. Select Biaxial Moment Interaction and then click on the shaft #1 in the Pile Selection window. The interaction diagram is shown for the top segment shaft #1. This interaction diagram (Figure 2.28) shows the failure contour at the given axial load. The plot represents all possible cases of biaxial failure for the given section. For this example, there is only uniaxial bending from the applied loads. Points “I” and “J” on the diagram show the force combination for the current segment (element). Point “J” represents the top of the element and point “I” represents the bottom of the element. The remaining contour plots for the drilled shaft can be generated by clicking on any one of the 20 shaft segments in the Segment Selection window.
To view the interaction diagrams for the pier structure, click on the button in the top toolbar. Select Biaxial Moment Interaction and then click on the right column in the Structure window. The interaction diagram is shown for the bottom segment of the right column. This interaction diagram (Figure 2.29) shows the failure contour at the given axial load. The plot represents all possible cases of biaxial failure for the given column section. For this example, there is only uniaxial bending from the applied loads. Again, points “I” and “J” on the diagram show the force combination for the current segment (element). The remaining contour plots for the drilled shaft can be generated by clicking on any one of the 6 column segments in the Segment Edit window. You can also click on the other column or the pier cap to see additional interaction diagrams.
Figure 2.29 Pier Structure Interaction Diagram

The 3D Results can also be viewed as a final step in the analysis. To view the displaced shape of the pier system, click on the button in the top toolbar. The resulting screen should look like Figure 2.30. The displacement values can be obtained for each node. Click on the node in the 3D plot or select the node under Node Information to view the values. In addition to the displaced shape, you can also view the displacement contours and stresses in the pile cap by clicking the appropriate button in the 3D Display Control window.
This completes Example 2.
3. **RETAINING WALL**

Shown in Figure 3.1 is the retaining wall with geometry and soil conditions, which will be modeled in Example 3. The 12 ft high by 20 ft long cantilevered retaining wall has backfilled soil behind the wall and an existing soil base beneath the wall. The wall is supported by 2 rows of 12” H-piles. There is a surcharge strip load of 500 psf located 5 ft behind the wall. The soil properties and wall configuration are given in Figure 3.1.

![Figure 3.1 Example 3, Retaining Wall](image)

To begin modeling the retaining wall select New from the File menu after starting FB-MultiPier. Select Retaining Wall for the Structure Type and enter the information about the problem shown in Figure 3.2. Click OK when finished.
Figure 3.2 Select Retaining Wall, English units and enter project description.

FB-MultiPier now loads a default data set for the retaining wall problem. The screen is divided into four different windows as shown in Figure 3.3. The top left window is used to enter the retaining wall configuration, soil properties, and any other parameters for the problem. The bottom left window shows the wall and soil layers in an elevation view. The top right window shows the layout of the piles in a plan view and the bottom right window shows the entire foundation in a 3D view.

The default problem will be modified to model the retaining wall presented in Figure 3.1 at the beginning of Example 3.
This example will begin by modifying the structure properties by clicking on the Wall Structure tab in the Model Data window. For the retaining wall problem, the wall is modeled as a column with a wall width parameter equal to the 20 ft length of the wall. The program will apply the soil pressure using wall width parameter in order to correctly apply the loading along the entire wall. The soil properties are assumed to be uniform along the length of the wall.

For the example problem enter 13.5 ft for the Wall Height (measured from the center of the pile cap), 20 ft Wall Width. The wall offset is automatically set so that the wall is centered on the pile cap. Leave the remaining values as they are since they will not be used in this example. Select Gross Properties for this example. The Wall Structure tab dialog should now look like Figure 3.4.
Figure 3.4 Changing the Structure Properties

For this example, the wall is modeled with Gross Properties. To specify the section properties for the wall, click on the Edit Cross Section button. Enter the section properties for the 240” x 18” wall shown in Figure 3.5 and click OK when done.

Figure 3.5 Specifying Wall Section Properties
Note that since this example uses gross cross-sectional properties, the program will not be able to model the true length of the wall in the 3D View window. The wall will be modeled with a square cross-section. If full cross-section properties were specified, the section width and depth of the wall would be entered and the 3D View window would show the true size of the wall.

The remaining retaining wall properties can now be entered by clicking on the Retaining tab in the Model Data window. The dialog has a number of parameters for input. Currently, Soil Layer 1 is active. To model the example problem, enter 10 degrees for the Ground Slope Incline, 3 ft for the Ground Water Height, 12 ft for the Thickness of the layer. Enter 5 for the Number of Sub Layers to divide the wall into 5 segments from the base to the top. Finally, confirm that the Active Case soil pressure model is selected for this problem. The dialog should now look like Figure 3.6.

![Figure 3.6 Changing the Retaining Wall Properties](image)

Now select Layer 2 from the Soil Layer drop-down list. Click Delete to delete Soil Layer 2 since this example only has one layer of granular backfill soil. Click OK to confirm the deleting of the soil layer.

Now edit the soil layer data by clicking Layer Data in the Soil Layer Data section. Enter the values that are shown in the dialog in Figure 3.7a. Click OK when done to return to the Retaining tab.
To specify a surcharge load on the soil behind the wall as shown in Figure 3.1, click the Surcharge button in the Wall Load Data section of the Retaining Tab. Click on Strip Load and then enter 5 ft for the Wall Distance, 4 ft for the Load Width, and 500 psf for the Load Intensity to describe the loading. These values are shown in Figure 3.7b.

This completes the data entry for the retaining wall. Now the underlying soil and pile properties for this example need to be specified before proceeding with the analysis.

To edit the soil properties at the base of the wall, click on the Soil tab in the Model Data window. First make sure that Layer 1 is selected as the Soil Layer. Select a Cohesive soil from the Soil Type dropdown list. Now enter the Unit Weight as 107 pcf and the Undrained Shear Strength as 900 psf. Select the Soil Layer models shown in Figure 3.8. Finally, enter the Water Table elevation as 0 ft, the Top of Layer elevation as 0 ft, and the Bottom of Layer elevation as -80 ft. Make sure to include the negative sign in the bottom elevation to indication a downward direction.
The next step is to specify the parameters for the soil layer models. Click on the dropdown list or label for the Lateral models to activate the Lateral soil Model (the word “Lateral” should turn blue). Now click Edit to edit the lateral properties for the layer. Enter the values into the dialog shown in Figure 3.9a. Click OK when done to return to the Soil tab.

Figure 3.8 Specifying Soil Properties

Figure 3.9a Lateral Model Properties
Now specify the Axial soil properties. Click on the Axial dropdown label to active the Axial model, and then click Edit to edit the driven pile properties. The model is activated when the word “Axial” turns blue. Make sure that the values match the dialog shown in Figure 3.9b above. Most of the values should not need to be changed, but double check just to be sure. Click OK when done.

The Torsional model is based on previously defined values. To verify that the values are correct for this example problem, activate the Torsional model and click Edit. The values should appear as shown in the dialog in Figure 3.9c. If any values are different, change them now and click OK when done.
The Tip model is also based on previously defined values and values from the default parameter set. There is no need to change the values for this example. To view the values anyway, activate the Tip model and click Edit. The values should appear as shown in the dialog in **Figure 3.9d**. If any values are different, change them now and click OK when done.
This completes the soil data entry. The Soil tab dialog should now look like Figure 3.10. If any parameters are different change them now. At this point, only the pile configuration needs to be specified before proceeding to the analysis.
To specify the pile configuration, click on the Pile & Cap tab in the Model Data window. This example calls for two rows of 12 inch H-piles. First, select 12x84 H-Pile from the yellow Database list. To support the 20 ft width of retaining wall, enter 11 Grid Points in the Y-direction with a Spacing of 3d (36 inches). Click Yes to add a pile at all of the new grid points. A dialog now appears to remind you of the change in pile geometry and possible changes in the p-y multipliers. Click OK in the dialog to change the spacing. This reminder is important because if new pile rows are added, p-y multipliers must be assigned to these rows. Do this now in the Soil tab with the Group button. Default p-y multipliers can be assigned with the Default button or the user can specify their own at this point. First click on “Use PY Multipliers Specified” and then click the Defaults button for this example. Return back to the Pile & Cap tab and enter 4 for the Grid Points in the X-direction and change the spacing to 4d. Again click OK to add piles to the new grid points and confirm the change in spacing. Now apply overhang to the model by going to the Control menu and make sure the “Apply Overhang” has a check next to it. Now change the tip elevation of the piles by clicking the “Edit Cross Section” button. Change the length data to 60 ft and click OK. The Pile & Cap tab dialog should now appear as shown in Figure 3.11.

![Figure 3.11 Modifying the Pile Configuration](image)
The pile layout should now appear as shown in Figure 3.12.

Before leaving the Pile tab dialog, click the Edit Pile Cap button in the Cap Data section. In the dialog that appears, enter 3 ft for the cap thickness as shown in Figure 3.13. Click OK when done. This completes the data entry phase of the problem. Save the file if you haven’t already done so by clicking on the disk icon at the top of the screen. Type “Example3.in” for the name of the file. We can now proceed with the analysis.

Figure 3.12 H-Pile Configuration

Figure 3.13 Changing Pile Cap Thickness
To analyze the pier, click on the \( \text{\textbf{}} \) button at the top of the screen. A dialog appears showing the status of the analysis. The time needed for the analysis will depend on the speed of the computer. When the analysis is done close the window to continue.

To view the pile results, click on the \( \text{\textbf{}} \) button in the top toolbar. To demonstrate the plotting capabilities click on the pile labeled ‘1’ in the Pile Edit window and then click Apply in the Plot Display Control window. The screen should now look like Figure 3.14, which shows different plots for pile #1.

As an example, look at the plot of the axial soil force along the pile. Click on the Soil Axial window to signal the Plot Display Control Window to update the maximum and minimum force values. Notice that for pile #1, the largest axial force is 1.024 kip at 3.75 ft below the ground surface. Note that the positive sign indicates compression in the soil.

The plots for other piles can be generated at the same time by clicking on the pile number and then Apply. To remove a pile from the plots, click on the pile in the Pile Edit window to return the pile to its original color and click Apply. Use the check boxes to control the number of plots shown. Remember to click Apply to redraw the plots. The maximum force values can also be plotted for all load cases.
To view the retaining wall results, click on the button in the top toolbar. Click on the wall in the Structure window and then click Apply in the Plot Display Control window. The screen should now look like Figure 3.15, which shows different plots for the retaining wall. Use the check boxes to control the number of plots shown. Remember to click Apply to redraw the plots. The maximum force values can also be plotted for all load cases.

For this problem, notice that the maximum bending moment occurs at the base of the wall. The Moment 3 value at the base is 274.26 kip-ft. Also note that the shape of the moment diagram is cubic due to the distributed soil load behind the wall.
To view the interaction diagrams for the piles, click on the button in the top toolbar and select Biaxial Moment Interaction. Click on pile #1 in the Pile Edit. The interaction diagram is shown for the top segment of shaft #1. This interaction diagram (Figure 3.16) shows the failure contour at the given axial load. The plot represents all possible cases of biaxial failure for the given section. For this example, there is only uniaxial bending from the applied loads. Points ‘I’ and ‘J’ on the diagram show the force combination for the current segment (element). Point “J” represents the top of the element and point “I” represents the bottom of the element. The remaining contour plots for the pile can be generated by clicking on any one of the 16 shaft segments in the Segment Edit window.
Figure 3.16 Pile Interaction Diagram

For this example is not possible to plot the interaction diagram for the retaining wall since only the minimum linear properties were specified. Later, the user can return back to the wall properties and specify all of the section properties to generate an interaction diagram.

The 3D results can also be viewed as a final step in the analysis. To view the displaced shape of the wall system, click on the button in the top toolbar. The resulting screen should look like Figure 3.17. The displacement values can be obtained for each node. Click on the node in the 3-D plot or select the node under Node Information to view the values. In addition to the displaced shape, you can also view the displacement contours and stresses in the pile cap by clicking the appropriate button in the 3D Display Control window.
This concludes Example 3.
4. **HIGH MAST LIGHT/SIGN**

The high mast light/sign problem is relatively straightforward to model and analyze using FB-MultiPier. This example assumes that the user has already been exposed to many of FB-MultiPier’s features by working through the first three examples. The overall modeling will be touched on briefly using the default problem that is provided with FB-MultiPier, but the emphasis will be on modeling the mast arm.

The default high mast sign that FB-MultiPier provides is similar to the one shown in Figure 4.1. The problem consists of a cantilever mast arm on a column supported by a single drilled shaft. A line load is applied to the mast. Certain aspects of the mast structure will be changed to demonstrate some of the modeling features that FB-MultiPier offers. This will entail changing the mast arm length and loading.

![Figure 4.1 Mast Arm Example](image)

To begin, select New from the File menu. Select High Mast Light/Sign from the New Problem Type dialog and enter the information shown in Figure 4.2.
After clicking OK, the default data set is loaded. Figure 4.3 shows the general purpose input, which is split into 4 separate screens. The top left is referred to as the tab dialogs. These tabs control all soil, geometry, loads, analysis and problem types input. Note that the font in the tabbed dialogs depends on the screen resolution. To change the font go to the Control menu and choose Set Dialog Font and select a suitable viewing font for the tabbed dialog. The top right is the plan view of the piles, cap and coordinate system. By right clicking the mouse in this window, the user can delete, batter, and change the spacing of the piles. The bottom left window is the soil edit window. This window shows the elevation of all soil layers, water table, pile top and tip elevations, and general soil information. Right clicking the mouse in this window will also allow the users to insert, delete, and split layers. The bottom right window is the 3D view of the piles, cap and structure, if there is one. Right clicking the mouse in this window allows the user to view the structure in line mode, and rotate the structure with the mouse (3D rotate). The latter is useful for placing loads, springs, etc. on different nodes of the structure.
To modify the properties of the mast arm, click on the Pier tab in the Model Data window. Change the Cantilever length to 10 ft and change the Number of Cantilever Nodes to 10. The Pier tab dialog is now shown in Figure 4.4.

---

**Figure 4.3 Default High Mast Lighting Data Set**

**Figure 4.4 Changing Mast Arm Properties**
For this example, there is no need to change the pile or soil properties, as both were covered in the previous examples. The next step is to apply the loads to the mast arm. To do so, click on the Load tab. Delete the existing nodal loads using the “Del” button to the right of the nodal loads list. The mast arm line load is applied using the local coordinate axis. The local 3-direction corresponds to a negative y-direction. To model the load in this example, a negative sign must be placed in front of the load to apply the load in the positive y-direction. To change the line load for the mast arm, enter -0.167 kips/in (2 kips/ft) in the Mast Line Load box and change the Col. Line Load to 0. The Load tab dialog should now match Figure 4.5.

At this point, the analysis can be run to observe the behavior of the mast arm under the given loading. Click on the Analysis button in the toolbar to proceed.

To view the forces in the column, click on the Pier Results button in the toolbar. Click on the column to view the column results and verify by a quick calculation that the mast arm load was applied correctly. The force results are shown in Figure 4.6. Notice that the shear is 20 kips and the maximum moment is -167 kip-ft, which are correct for the given loading.
Figure 4.6 Force Results for the Column

To view the deformed shape of the mast arm under the applied loading, clicking on the 3D Results button in the toolbar. Figure 4.7 shows the 3D deformation of the mast arm.
Figure 4.7 3D Results for the Mast Arm

This completes Example 4.
5. **SOUND WALL**

This example, like the high mast lighting example, assumes that the user has already been exposed to many of FB-MultiPier’s features by working through the first three examples. The overall modeling will be touched on briefly using the default problem that is provided with FB-MultiPier, but the emphasis will be on modeling the sound wall.

The default sound wall that FB-MultiPier provides is similar to the one shown in **Figure 5.1**. The problem consists of a sound wall that is supported on a 2x2 pile group. The wall is supported by 1ft x 1ft columns spaced at 4 feet. A 50 psf wind pressure is applied to the wall. Certain aspects of the wall structure will be changed to demonstrate some of the modeling features that FB-MultiPier offers. This will entail changing the wall height, width, and loading.

![Figure 5.1 Sound Wall Example](image)

To begin, select New from the File menu. Select Sound Wall from the New Problem Type dialog and enter the information shown in **Figure 5.2**.
Figure 5.2 Select Sound Wall

After clicking OK, the default data set is loaded. Figure 5.3 shows the general-purpose input, which is split into 4 separate screens. The top left is referred to as the tabbed dialogs. These tabs control all soil, geometry, loads, analysis and problem types (check tabs) input. Note that the font in the tabbed dialog depends on the screen resolution. To change the font go to the Edit menu and choose Set Dialog Font and select a suitable viewing font for the tabbed dialog. The top right is the plan view of the piles, cap and coordinate system. By right clicking the mouse in this window, the user can delete, batter, and change the spacing of the piles. The bottom left window is the soil edit window. This window shows the elevation of all soil layers, water table, pile top and tip elevations, and general soil information. Right clicking the mouse in this window will also allow the users to insert, delete, and split layers. The bottom right window is the 3D view of the piles, cap and structure, if there is one. Right clicking the mouse in this window allows the user to view the structure in line mode, and rotate the structure with the mouse (3D rotate). The latter is useful for placing loads, springs, etc. on different nodes of the structure.
Figure 5.3 Default Sound Wall Data Set

To modify the properties of the sound wall, click on the Wall Structure tab in the Model Data window. Change the Wall Height to 15 feet and the Wall Width to 4 feet, the Wall Offset will automatically center the wall on the pile cap. The Wall Width is used to designate the length of wall between columns. The Wall Structure tab dialog is now shown in Figure 5.4.

Figure 5.4 Changing Mast Arm Properties
The dimensions of the wall will now be changed. Click on the Edit Cross Section button under Cross Section Type of Wall Structure tab. Confirm that both the Width and Depth are 12 inches as shown in Figure 5.5. Next Click on the Edit Section Contents button in the Section Type section and change the existing reinforcement from prestressing steel to mild steel. To do this, change the Prestress After Losses to 0 ksi and click the Mild Steel button to signal the program to use mild steel instead (mild steel is shown as blue, prestressing steel is show as red). This must be done for each of the four steel groups. The cross-section with mild steel should now look like Figure 5.6. Click OK to dismiss the Rectangular Section Properties dialog and return to the Pier Component Properties dialog.

While in the Pier Component Properties dialog click on the Edit Properties button under Material Properties to specify the steel properties. Click on the Mild Steel check box and enter 60 ksi for the Yield Stress and 29000 ksi for the Modulus as shown in Figure 5.7. Click OK to dismiss the Stress-Strain Dialog. Click OK in the Pier Component Properties dialog to apply the changes and dismiss the dialog.

![Figure 5.5 Beginning Sound Wall Properties](image-url)
Figure 5.6 Changing Sound Wall Reinforcement

Figure 5.7 Specify Steel Properties
The final step before running the analysis is to apply a wind load to the sound wall. To apply a wind pressure to the sound wall, first click on the Load tab. Click on the Wind Pressure load and change the wind pressure from 23 psf to 50 psf as shown in Figure 5.8. This pressure will be applied to the width of the sound wall (currently 4 feet).

![Figure 5.8 Changing Sound Wall Load Properties](image)

This completes the data entry portion of the example. To analyze the sound wall click the Analysis button in the toolbar. When the analysis is complete, click on the Pier Interaction button and select Biaxial Moment Interaction. The interaction diagram for the wall is shown in Figure 5.9. The element at the column base is currently selected. Notice that the top of element #1 (marker “J”) is within the failure curve, but the bottom of element #1 (marker “I”) is not. This indicates a failure condition at that the base of the column. Click on element #2 to see that both the top and bottom of the element are within the failure curve. This problem requires a redesign of the cross-section in order to achieve a safe loading condition at the base of the column.
This completes Example 5.
6. STIFFNESS FORMULATION

FB-MultiPier can be used to determine an equivalent foundation stiffness that can be exported to other analysis programs. This option creates a 6x6 foundation stiffness.

The default stiffness problem that FB-MultiPier provides is shown in Figure 6.1. The problem consists of a pile cap supported on a 3x3 pile group. A combination of forces and moments in applied to a node in the first pile. FB-MultiPier will apply these loads to determine the equivalent 6x6 stiffness matrix of the foundation.

![Figure 6.1 Stiffness Example](image)

Reese Sand
\[ \gamma = 119 \ \text{lb/ft}^3 \]
\[ \phi = 35^\circ \]

80 ft

The equivalent foundation stiffness is determined by applying all of the loads in the first load case at once. After an equilibrium solution has been obtained, unit loads are independently applied by the program for each of the six degrees of freedom while the structure is in the equilibrium position. The displacements obtained from each of the unit load applications are used to fill the 6x6 equivalent foundation stiffness matrix. Because FB-MultiPier applies the unit loads in the equilibrium position, a coupled behavior between the degrees of freedom is expected.

To begin a stiffness formulation problem, select New from the File menu. Select Stiffness as shown in Figure 6.2. The program screen with the default problem is shown in Figure 6.3.
For this example there is no need to modify any of the problem parameters. To run the stiffness formulation analysis, click on the Analysis button in the toolbar. The equivalent stiffness matrix is written at the bottom of the output file for the analysis. The quickest way to view the output file is from the Control menu. Selecting View Analysis Data from the Control menu launches Microsoft Notepad or WordPad depending on the size of the output file.
The results from the stiffness formulation analysis are shown in Table 3.6.1 below:

<table>
<thead>
<tr>
<th></th>
<th>DeltaX</th>
<th>DeltaY</th>
<th>DeltaZ</th>
<th>ThetaX</th>
<th>ThetaY</th>
<th>ThetaZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fx</td>
<td>0.8242E+02</td>
<td>-0.1544E+02</td>
<td>0.3267E+00</td>
<td>0.5563E+02</td>
<td>0.1022E+02</td>
<td>-0.1970E+05</td>
</tr>
<tr>
<td>Fy</td>
<td>-0.1544E+02</td>
<td>0.1432E+05</td>
<td>0.2348E+01</td>
<td>-0.3451E+03</td>
<td>-0.2044E+00</td>
<td>0.1759E+05</td>
</tr>
<tr>
<td>Fz</td>
<td>0.3267E+00</td>
<td>0.2348E+01</td>
<td>0.1074E+03</td>
<td>0.2364E+05</td>
<td>0.8794E+02</td>
<td>-0.5750E+02</td>
</tr>
<tr>
<td>Mx</td>
<td>0.5563E+02</td>
<td>-0.3451E+03</td>
<td>0.2364E+05</td>
<td>0.5792E+08</td>
<td>0.6423E+05</td>
<td>-0.1387E+06</td>
</tr>
<tr>
<td>My</td>
<td>0.1022E+02</td>
<td>-0.2044E+00</td>
<td>0.8794E+02</td>
<td>0.6423E+05</td>
<td>0.2388E+07</td>
<td>-0.8972E+04</td>
</tr>
<tr>
<td>Mz</td>
<td>-0.1970E+05</td>
<td>0.1759E+05</td>
<td>-0.5750E+02</td>
<td>-0.1387E+06</td>
<td>-0.8972E+04</td>
<td>0.5626E+08</td>
</tr>
</tbody>
</table>

Table 3.6.1 Equivalent Stiffness Matrix (Foundation Stiffness in Standard X-Y-Z)

For the stiffness matrix in Table 3.6.1, the 1, 2, and 3 headings correspond to the x, y, and z translations and the 4, 5, and 6 headings correspond to the rx, ry, and rz rotations. As explained earlier, the stiffness matrix is fully populated.

Before using the equivalent stiffness matrix in another analysis programs, it is important to understand the coordinate system used by FB-MultiPier. The following explanation shows how to
convert a 6x6 stiffness matrix from the FB-MultiPier global coordinate system to a standard coordinate system defined below.

![Figure 6.4 FB-MultiPier and Standard Coordinate Systems](image)

A 3x3 transformation matrix (T) is first defined to show how the two coordinate systems are related.

\[
\begin{bmatrix}
  x \\
  y \\
  z \\
\end{bmatrix} = \begin{bmatrix}
  1 & 0 & 0 \\
  0 & 0 & 1 \\
  0 & -1 & 0 \\
\end{bmatrix} \begin{bmatrix}
  X \\
  Y \\
  Z \\
\end{bmatrix}
\]

Which can be stated as \([d] = [T][D]\).

This shows that \(x\) maps to \(X\), \(y\) maps to \(Z\), and \(z\) maps to \(-Y\).

This transformation matrix is then used to transform the stiffness matrix from the FB-MultiPier coordinate system to the standard coordinate system as follows.

\[
[K_{\text{STANDARD}}] = [T]^T [K_{\text{FB-MULTIPIER}}][T]
\]

\[
[K_{\text{STANDARD}}]_{6x6} = \begin{bmatrix}
  1 & 0 & 0 & 0 & 0 & 0 \\
  0 & 0 & -1 & 0 & 0 & 0 \\
  0 & 1 & 0 & 0 & 0 & 0 \\
  0 & 0 & 0 & 1 & 0 & 0 \\
  0 & 0 & 0 & 0 & 1 & 0 \\
  0 & 0 & 0 & 0 & 0 & 1 \\
\end{bmatrix} \quad [K_{\text{FB-MULTIPIER}}]_{6x6} = \begin{bmatrix}
  1 & 0 & 0 & 0 & 0 & 0 \\
  0 & 0 & 1 & 0 & 0 & 0 \\
  0 & -1 & 0 & 0 & 0 & 0 \\
  0 & 0 & 0 & 1 & 0 & 0 \\
  0 & 0 & 0 & 0 & 1 & 0 \\
  0 & 0 & 0 & 0 & 0 & 1 \\
\end{bmatrix}
\]

This requires 2 matrix multiplications to obtain the transformed stiffness matrix. This can be easily done using either Excel or MathCad.
As a result, to convert the FB-MultiPier stiffness to a standard coordinate system, use the following.

<table>
<thead>
<tr>
<th>K_{11}</th>
<th>K_{12}</th>
<th>K_{13}</th>
<th>K_{14}</th>
<th>K_{15}</th>
<th>K_{16}</th>
</tr>
</thead>
<tbody>
<tr>
<td>K_{21}</td>
<td>K_{22}</td>
<td>K_{23}</td>
<td>K_{24}</td>
<td>K_{25}</td>
<td>K_{26}</td>
</tr>
<tr>
<td>K_{31}</td>
<td>K_{32}</td>
<td>K_{33}</td>
<td>K_{34}</td>
<td>K_{35}</td>
<td>K_{36}</td>
</tr>
<tr>
<td>K_{41}</td>
<td>K_{42}</td>
<td>K_{43}</td>
<td>K_{44}</td>
<td>K_{45}</td>
<td>K_{46}</td>
</tr>
<tr>
<td>K_{51}</td>
<td>K_{52}</td>
<td>K_{53}</td>
<td>K_{54}</td>
<td>K_{55}</td>
<td>K_{56}</td>
</tr>
<tr>
<td>K_{61}</td>
<td>K_{62}</td>
<td>K_{63}</td>
<td>K_{64}</td>
<td>K_{65}</td>
<td>K_{66}</td>
</tr>
</tbody>
</table>

FB-MultiPier Stiffness Matrix

<table>
<thead>
<tr>
<th>K_{11}</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>K_{15}</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>K_{33}</td>
<td>0</td>
<td>-K_{36}</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>K_{22}</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>-K_{43}</td>
<td>0</td>
<td>K_{44}</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>K_{66}</td>
<td>0</td>
</tr>
<tr>
<td>K_{51}</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>K_{55}</td>
</tr>
</tbody>
</table>

Standard Coordinate Stiffness Matrix

Note: Both the locations and signs change for some of the stiffness terms.

**Example**

The FB-MultiPier stiffness matrix is given by

<table>
<thead>
<tr>
<th>20</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>6500</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>20</td>
<td>0</td>
<td>-6500</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>26000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>-6500</td>
<td>0</td>
<td>1.00E+08</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>6500</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1.00E+08</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Then the stiffness matrix in the standard coordinate system would be.

<table>
<thead>
<tr>
<th>20</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>6500</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>26000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>20</td>
<td>-6500</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>-6500</td>
<td>1.00E+08</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>6500</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1.00E+08</td>
<td>0</td>
</tr>
</tbody>
</table>

This completes Example 6.
7. MULTIPLE PILE SETS

Shown in Figure 7.1 is the pile group with geometry and soil conditions, which will be modeled in Example 7. The problem represents a pile group that is expanded due to increasing demands from the superstructure. The original foundation consisted of 9-24 inch prestressed piles (60 ft long), embedded in a 5 ft thick pile cap. The revised foundation will add 30 inch piles around the perimeter with a depth of 80 ft. The pile cap thickness will also be increased to 8 ft. The properties of the sand and rock are given in Figure 7.1.

![Figure 7.1 Example 7, Revised Pile Group](image-url)

- Reese Sand, $\gamma_t = 109$ pcf, $\phi = 32$
- Reese Sand, $\gamma_t = 119$ pcf, $\phi = 35$
- 200 kip
- 500 kip
- 3'
- 15'
- 20'
- 45'
From the File menu in Figure 7.2, select New. Choose Pile and Cap Only and enter the general information shown in Figure 7.3. Be sure to choose the English systems of units to load the correct default data set.
After clicking OK at bottom of dialog, the default data set is loaded. Figure 7.4 shows the general-purpose input, which is split into 4 separate screens. The top left is referred to as the Model Data window. The Model Data window contains dialogs that control all soil, geometry, loads, analysis and problem types input. The top right is the plan view of the piles, cap and coordinate system. By right clicking the mouse in this window, the user can delete, batter, and change the spacing of the piles. The bottom left window is the Soil Edit window. This window shows the elevation of all soil layers, water table, pile top and tip elevations, and general soil information. Right clicking the mouse in this window will also allow the users to insert, delete, and split layers. The bottom right window is the 3D View of the piles, cap and structure, if there is one. Right clicking the mouse in this window allows the user to view the structure in thin elements mode, and rotate the structure with the mouse (3D rotate). The latter is useful for placing loads, springs, etc. on different nodes in the structure.

Figure 7.4 Default Data Set (2x2 Pile Group)

To model the example problem, click the Pile & Cap tab in the Model Data window. Change the number of grid points in the X and Y-direction to 7, clicking OK to add piles to the new grid points. Now
there are 25 piles arranged in a 5x5 pile group with an overhang. The default problem has 18” precast piles. To change the pile type click on the yellow Pile/Shaft Type list and select a Precast > Square FDOT 24” Standard prestressed pile. FB-MultiPier will prompt to see if the grid spacing should be changed based on the pile size, click OK for both X and Y directions. The Model Data window should now look like Figure 7.5.

![Figure 7.5 Pile & Cap Tab Dialog Adjusted for Number and Type of Pile](image)

The next step is to edit the pile cap properties. To do this, click on Edit Pile Cap in the Pile Cap Data section. Change the cap Thickness to 8 ft and then click OK to confirm the change and exit the dialog. The Cap Properties dialog should appear as shown in Figure 7.6.

![Figure 7.6 Pile Cap Properties](image)
The four split screen inputs should look like Figure 7.7. Note the Pile Edit window (top right) shows 25 piles.

![Figure 7.7 General Input Screen for Pile Group](image)

The different pile types shown in Figure 7.1 can now be specified in the Pile & Cap tab dialog. Click the Edit Cross Section button to edit the pile types. The Full Cross Section Pile Properties dialog appears, allowing the user to change the pile properties.

Different pile sets must be used in order to assign different pile types to the pile group. For this problem, two pile sets will be used: one for the 24” piles (with a length of 60 ft) and one for the 30” piles (with a length of 80 ft). Note that if all the piles were the same (in cross-section and length) then only one pile set is needed. This pile set is assigned to all piles by default.

All that needs to be done to create the first pile set is to modify the length of the default 24” pile to match the length specified in Figure 7.1. Under Section Dimensions change the Length value to 60 feet.
To create the second pile set, click the Add button below the Pile Set Info list in the upper left portion of the dialog as shown in Figure 7.8.

![Figure 7.8 Adding a Pile Set](image)

The second pile set “Set 2” will be automatically selected, click the Retrieve Section button and select Rectangular > 30” Square FDOT Standard prestressed pile and change the pile length to 80 feet. The dialog should now look like Figure 7.9. Click OK to update the changes and exit the dialog. FB-MultiPier will again ask to update the grid spacing because the pile dimensions have been changed, approve these changes by clicking OK.
The Pile Edit window is used to assign the pile sets to the piles. By default, all of the piles are assigned to pile set 1. This example problem calls for changing the perimeter piles to 30”, which are specified in pile set 2. The pile set is specified while in the Pile Data/Batter mode. Right click the mouse button in the Pile Edit window and check that this mode is selected. Click on Pile 1 in the bottom left of the group. The pile data dialog is displayed with the pile information for Pile 1. Select Pile Set 2 from the list as shown in Figure 7.10 and click OK. Notice that a different pattern is shown on the pile head to indicate the different pile set. Repeat this for process for all of the perimeter piles. When done the Pile Edit window should look like Figure 7.11.
For this problem it is not necessary to change the soil properties but the soil elevations must be changed. In the Soil tab, change the top layer elevation from –10 feet to 0 feet. Now select Layer 2 from the Soil Layer list. Change the bottom elevation to –90 ft. This elevation is deep enough for the new piles added with pile set 2. The Soil tab dialog should now look like Figure 7.12.
Now click the Load tab to apply the prescribed loads to the pile group. First delete Load Case 2 with the Del button. Now there should only be one load case. Now delete the existing nodal loads with the right Del button. The loads in this example will be applied to the center of the pile cap. Click on the center node (Node 13) in the 3D Edit window. The node should turn orange to indicate that it has been selected. Click the right Add button and enter 200 kips for the X Load and 500 kips for the Z Load. The Load tab dialog should now look like Figure 7.13.
This completes the data entry portion of the example. To analyze the new pile group click the Analysis button in the toolbar. When the analysis is complete, click on the Pile Results button in the toolbar. The forces in the different pile sections can be compared. As an example, select Piles 2 and 7. Select the Shear, Moment, Axial, and Demand/Capacity Ratio for plotting. Click Apply to plot the applicable values. The plots should look Figure 7.14.

The load moment interaction and 3D results can also be viewed for further investigation of the pile group behavior.

![Figure 7.14 Force Results for the Pile Group](image)

This concludes Example 7.
8. **PILE BENTS**

Shown in Figure 8.1 is a pile bent model with geometry and soil conditions, which will be modeled in Example 8. The problem consists of a single row of battered piles connected directly to a bent cap. The 9 square precast piles are 14 inches in width and are spaced 4 diameters apart. The square bent cap is 36 inches in width and 36 feet long. The foundation is subjected to the 3 longitudinal 30 kip concentrated loads shown in Figure 8.1.

![Figure 8.1 Pile Bent Model](image)

[Reece Sand \( \gamma_I = 119 \text{pcf} \)  
\( \phi = 35\text{deg} \)]
From the File menu in Figure 8.2, select New. Choose Pile Bent and enter the general information shown in Figure 8.3. Be sure to choose the English systems of units to load the correct default data set.
After clicking OK at bottom of dialog, the default data set is loaded. **Figure 8.4** shows the general-purpose input, which is split into 4 separate screens. The top left is referred to as the Model Data window. The Model Data window contains tabbed dialogs that control all soil, geometry, loads, analysis and problem types input. The top right is the plan view of the piles, cap and coordinate system. By right clicking the mouse in this window, the user can delete, batter, and change the spacing of the piles. The bottom left window is the Soil Edit window. This window shows the elevation of all soil layers, water table, pile top and tip elevations, and general soil information. Right clicking the mouse in this window will also allow the users to insert, delete, and split layers. The bottom right window is the 3D View of the piles, cap and structure, if there is one. Right clicking the mouse in this window allows the user to view the structure in thin elements mode, and rotate the structure with the mouse (3D rotate). The latter is useful for placing loads, springs, etc. on different nodes in the structure.

![Figure 8.4 Default Data Set (Pile Bent)](image)

To model the example problem, click the Pile & Cap tab in the Model Data window. Change the number of grid points in the X-direction to 9, adding piles at the new grid locations. Notice that the Y-direction grid points edit box is disabled since it is assumed that pile bents only have one row of piles.
Change the X-grid spacing to “Constant” and enter 56 inches for the constant spacing and click OK. The Model Data window should now look like Figure 8.5.

![Figure 8.5 Pile & Cap Tab Dialog Adjusted for Number of Piles](image)

The pile batter can be specified now that the correct number of piles and pile spacing has been select. The example problem calls for battering the first two and last two piles in the row. To batter the first pile, click on pile 1 in the Pile Edit window. The Pile Data dialog is displayed. The pile batter in specified in terms of the slope. For this example, enter –0.2 for the Y pile batter as shown in Figure 8.6. Click OK when done to apply the batter changes and close the Pile Data dialog.

![Figure 8.6 Entering the Pile Batter Data](image)
To batter the second pile, click on pile 2 in the Pile Edit window. This pile will be battered in the positive direction. Enter +0.2 for the Y pile batter and click OK to exit the dialog. Follow the same procedure for battering piles 8 and 9, assigning a \(-0.2\) Y batter for pile 8 and a \(+0.2\) Y pile batter for pile 9. When done the 3D Edit window should look like Figure 8.7.

![Figure 8.7 3D View of the Battered Piles](image)

With the pile batters finished the bent cap properties can be set. Select the Bent Cap tab in the Model Data Window. Click the Edit Cross Section Button under Cross Section Type which will bring up the Gross Pier Component Properties dialog. From this dialog all the relevant properties for the Bent Cap can be entered. First, enter 1296 for Area and 150 for Weight under the Section Data section. Enter the following Section Properties:

- Inertia 2 Axis - 139968
- Inertia 3 Axis – 139968
- Torsional Inertia – 279936
- Young’s Modulus – 4300
- Shear Modulus – 1796

The Gross Pier Component Properties dialog should now look like Figure 8.8.
The final modeling step is to apply the prescribed concentrated loads to the pile bent. To do so, first click on the Load tab in the Model Data window. The concentrated loads will be applied in the negative y direction at the pile heads for piles 3, 5, and 7. Remove the existing loads by selecting each node listed under Node Applied and clicking the Delete button to the right. Now add the new load to Node 3 by clicking on node 3 in the 3D View window or selecting node 3 from the Node # Dropdown menu. Click the right Add button then enter –30 kips for the Y load. Do the same for nodes 5 and 7. For this example, leave the Self Weight and Buoyancy Factors as zero. These values can be specified to included self weight and buoyancy in the analysis. The Load tab dialog should now look like Figure 8.9.

![Figure 8.8 Section Properties for Bent Cap](image)
This completes the data entry portion of the example. To analyze the new pile bent click the Analysis button in the toolbar. When the analysis is complete, click on the Pile Results button in the toolbar. To compare the pile forces for this example, click on piles 1, 2, and 3 in the Pile Selection window. Select the Shear, Moment, Axial, and Demand/Capacity Ratio for plotting. Click Apply to plot the applicable values. The plots should look Figure 8.10.
Notice that the Demand/Capacity Ratio for pile 1 is 0.476, representing a safe loading condition for the exterior pile. This can also be confined by examining the biaxial load interaction diagram for the pile. The 3D results can also be examined to understand the 3D behavior of the pile bent.

This concludes Example 8.
9. COLUMN ANALYSIS

Shown in Figure 9.1 is a single column model, which will be analyzed in Example 9. This type of problem allows the user to perform a biaxial bending analysis for a single column. This is done internally by taking a single pile and treating it as a single column. The single column has the ability to put springs at the top and bottom of the column. It also allows loads at the top and bottom. The column properties are input as normal pile properties.

Figure 9.1 Column Analysis Model
From the File menu in Figure 9.2, select New. Choose Column Analysis and enter the general information shown in Figure 9.3. Be sure to choose the English systems of units to load the correct default data set.
After clicking OK at bottom of dialog, the default data set is loaded. **Figure 9.4** shows the general-purpose input, which is split into 4 separate screens. The top left is referred to as the Model Data window. The Model Data window contains tabbed dialogs that control all soil, geometry, loads, analysis and problem types input. The top right is the plan view of the piles, cap and coordinate system. By right clicking the mouse in this window, the user can delete, batter, and change the spacing of the piles. The bottom left window is the Soil Edit window. This window shows the elevation of all soil layers, water table, pile top and tip elevations, and general soil information. Right clicking the mouse in this window will also allow the users to insert, delete, and split layers. The bottom right window is the 3D View of the piles, cap and structure, if there is one. Right clicking the mouse in this window allows the user to view the structure in thin elements mode, and rotate the structure with the mouse (3D rotate). The latter is useful for placing loads, springs, etc. on different nodes in the structure.

![Figure 9.4 Default Data Set (Column Analysis)](image)

To model the example problem, click the Pile & Cap tab in the Model Data window. Notice that the number of X and Y grid points are set to one and disabled for this type of problem. Change the pile/shaft type to 30" Square FDOT Standard prestressed for the column cross-section. Also, click the
“Edit Cross Section” button and change the length to 20 ft. Click OK when done. The Model Data window should now look like Figure 9.5.

![Figure 9.5 Adjusted Pile & Cap Tab Dialog - 30" Pile (Column)](image)

The next modeling step is to apply the prescribed concentrated loads to the column model. To do so, first click on the Load tab in the Model Data window. The concentrated loads will be applied to the top of the column. Select Load Case 2 and remove it by clicking the left Delete button. Now, enter 200 kips Z load and 1200 kips Moment Y, as shown in Figure 9.6 for Load Case 1, Node 1.

![Figure 9.6 Applied Loads to the Top of the Column](image)
Next, click on the Springs tab in the Model Data window to inspect the spring stiffness values at the top and bottom of the column. The values shown in Figure 9.7 do not need to be changed since the values from the default input file are fine.

The 3D view of the column system now should look like Figure 9.8.
This completes the data entry portion of the example. To analyze the new column click the Analysis button in the toolbar. When the analysis is complete, click on the Pile Results button in the toolbar. To examine the force results for the pile (column), click on the pile in the Pile Selection window. Select the Shear, Moment, Axial, and Demand/Capacity Ratio for plotting and uncheck the soil forces since they are not applicable. Click Apply to plot the applicable values. The plots should look Figure 9.9.

![Figure 9.9 Pile (Column) Load Results](image)

Notice that the moment at the top of the column matches the moment applied to the column, therefore indicating force equilibrium. Also notice that the axial load is 200 kips in compression when matches the applied concentrated load.

As a last step, click the Pile Interaction toolbar button to view the biaxial load-moment interaction. Doing so shows the plot presented in Figure 9.10. The figure shows that the applied loading
is well outside the failure envelope. In other words, this example represents a unsafe application of the specified loading and would need to be redesigned in order to achieve a safe loading condition.

This concludes Example 9.
10. **AASHTO LOAD COMBINATIONS**

Shown in Figure 10.1 is the bridge pier with geometry and soil conditions, which was modeled in Example 2. The problem represents a navigable waterway crossing, which involves both lateral and axial loads. The foundation consists of 6-54 inch drilled shafts (80 ft long), and two pier columns which are 30 ft tall, 5 ft square and spaced 16 ft apart. The pier cap is 4 ft thick and the drilled shaft cap is 10 ft thick with a 4.5 ft overhang. Due to scour, the sand surface is located 15 ft below mean sea level, and the soft rock is characterized as FHWA's intermediate geomaterial (IGM). The properties of the sand and rock are given in Figure 10.1.

![Figure 10.1 Example 2, Pier Structure](image)

This example will first consider AASHTO LRFD design load combinations to determine the worst case loading scenario. Design loads using the AASHTO Standard Specifications (LFD) will then be considered for comparison.
The following load types will be considered:

<table>
<thead>
<tr>
<th>Load Type</th>
<th>Bearing 1</th>
<th>Bearing 2</th>
<th>Bearing 3</th>
<th>Bearing 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead Load (DC)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Superstructure Dead Load</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dead Load (DW)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Superstructure Dead Load</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Live Load (LL1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vehicular Live Load</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impact Load (IM1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vehicular Dynamic Load Allowance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Braking Load (BR1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>y-direction (longitudinal) load</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Live Load (LL2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vehicular Live Load</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Impact Load (IM2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vehicular Dynamic Load Allowance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Braking Load (BR2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>y-direction (longitudinal) load</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Wind Load on Structure (WS) To be generated using wind angles of 0, 30, and 60 degrees

Wind Load on Live Load (WL) To be generated using wind angles of 0, 30, and 60 degrees

Vessel Collision (CV) Node 38 1000 kips (Lateral - Applied to center of pile cap)

The following LRFD limit states will be checked:

STRENGTH-I, STRENGTH-III, STRENGTH-V, EXTREME-II
To begin, select Open from the File menu and choose the Example2.in file. Change the Project Data and then select Save As from the File menu to save the problem under a different name. Call this new file Example10.in. The example problem is shown below in Figure 10.2.

![Figure 10.2 Example 10, Pier Structure](image)

Most of the work in this example involves entering the AASHTO type design loads. Many of these loads are applied at the bearing locations on the pier. The program requires that these bearing locations be defined before applying any AASHTO type design loads. To do so, click on the Pier tab in the Model Data window. Check the “Use Bearing Loc.” box to include bearing locations and then click on the “Bearing Locs.” button to entering the bearing positions. Enter the values shown in Figure 10.3. The negative value for the Offset from leftmost column positions the first bearing location to the left of the first pier column. Click OK when done.
Figure 10.3 Bearing Locations

The bearing locations are now shown in the 3D View window (Figure 10.4).

Figure 10.4 Bearing Locations
The problem can then be converted to an AASHTO type problem after entering the bearing locations. To do so, click on the Analysis tab and check the “AASHTO Combinations” box to initiate AASHTO load combinations as shown in **Figure 10.5**.

![Figure 10.5 AASHTO Combinations Option](image)

At this point a message box (**Figure 10.6**) is displayed to remind the user that design load types are assigned using the Load tab.

![Figure 10.6 Assigning load types](image)

The AASHTO LRFD design loads can now be entered. To do so, click on the Load tab. When working with AASHTO loads, each load case represents a different design load type (there are currently 25 load types in the LRFD code). Currently, there is only the preload case (from Example2) as all load cases are removed when switching to AASHTO mode. The “Table” button can be used to quickly apply
loads using a spreadsheet style format. Click the Table button to view the AASHTO Load Table as shown in Figure 10.8.

![Figure 10.8 Empty AASHTO Load Table](image)

A load case for the Dead Load of Components will be added first. To add this case, click on “Dead Load Comp” in the list of Load Types. Click the “€ Add Case” button to insert the load case. In the AASHTO Load Table, nodal loads are grouped into design load cases. These cases are shown in the folder tree in the first column of the table. Click on the “+” or “-” next to the folder to expand or compact the folder for easier management. Under the Load Case name in the first column the nodal locations are shown, notice that the nodes listed are identified as bearing locations. Enter the specified Z load of 150 kips for each bearing location listed, when done, the table should look like Figure 10.9.
The remaining columns in the load table describe a particular load. The second column shows the AASHTO design load type for the load. Columns three through eight show the load values for the six degrees of freedom.

A load case for the Dead Load of the Wearing Surface will be added next. To add this case, click on “Dead Load Wearing” in the list of Load Types. Click the “Add Case” button to insert the load case. Enter the specified wearing surface loads. When done, the table should look like Figure 10.10.
Figure 10.10 AASHTO Load Table, Dead Load of Wearing Surface

The two live load cases specified in this example will be added next. To add the first live load case, click on “Live Load” in the list of Load Types and click the “Add Case” button. Notice that an Impact load case (IM) and a Vehicle Braking (BR) load case are automatically inserted into the load table to accompany the live load. *In the FB-MultiPier program, every live load case must also have an impact case and a vehicle braking case.* If the user does not wish to enter loads for the impact and braking cases, they can leave all of the bearing load values as zero. Enter the specified loads for this example problem. When done, the table should look like Figure 10.11.
Now enter the loads for Live Load 2. When done, the table should look like Figure 10.12.

![Figure 10.12 AASHTO Load Table, Live Load 2](image)
The vessel collision case (CV) can now be specified. Add a load case for Vessel Collision. When adding a load case that does not require bearing location, a dummy nodal load placeholder is added to the load case. This placeholder is called ‘Node 1’ until the user changes the node number. For this example, the vessel collision load will be applied to the center of the left edge of the pile cap (Node 38). Double click on “Node 1” to edit the entry and change the value to “Node 38.” Now enter 1000 kips for the x-direction load. When done the table should look like Figure 10.13.

![Figure 10.13 AASHTO Load Table, Vessel Collision Load](image)

Although the Wind Load on Structure and Wind Load on Live Load cases can also be created using the AASHTO Load Table, this example will use the Wind Load Generator to automatically create the necessary wind load cases.

Before leaving the AASHTO Load Table it is worth mentioning some of the options available when editing the load cases. The “Remove Case” button is used to remove a load case from the table. Note that before clicking the “Remove Case” button, you must first click on the load case in the tab that is to be removed. Also, when removing a Live Load, the corresponding Impact and Braking cases are
automatically removed. The “Add Load” button is used to add nodal loads to a load case. A load case must be selected before clicking the button. The “Remove Load” button is used to remove nodal loads from a load case. The nodal load must be selected before clicking the button. Note that for adding and deleting loads, the user can also right click the mouse button on a nodal load to insert or delete a load. Finally, bearing loads cannot be deleted. The user should enter zero for the bearing load values if the bearing load is not applicable.

Click OK to save the changes to the AASHTO Load Table.

The next step in the example is to specify the parameters used in computing the AASHTO load combinations. The AASHTO tab (Figure 10.14) allows the user to select the LFRD or Standard Specifications (LFD) code as well as edit any of the load factors. Additionally, the Limit States of interest can be checked. Next, the “Automated AASHTO Loads” section allows the user to automatically generate self weight, buoyancy, and wind load cases. Also in this section is a display of the “Total Number of Combinations” as well as a “Preview Load Combinations” button to preview all load combination equations before running the analysis.

Figure 10.14 AASHTO Tab
To begin, click the “Edit Load Factors” button. Although this example does not call for modifying any of the load factors, it is worth demonstrating the feature here. An AASHTO Load Factor Table will be displayed (Figure 10.15) with all of the applicable load factors. These factors pertain to a given limit state, so changing the value of the DC load factor in STRENGTH-I, for example, will not change the DC load factor for the remaining limit states. Also, certain load factors have a range of values depending on the type of structure and whether the load case is considered for maximum or minimum load effects. The program assumes the first value in the range of values specified in the AASHTO LRFD code. The user has the option of changing these values using this table. Click Cancel to leave all load factors with their default values.

![AASHTO Load Factor Table](image)

Figure 10.15 AASHTO Load Factor Table

In the AASHTO tab, check the STRENGTH-I, STRENGTH-III, STRENGTH-V, and EXTREME II boxes to evaluate the load combinations for each of these limit states. Notice that while checking the limit state boxes, the “Total Number of Combinations” value is automatically updated. Its current value of ‘4’ does not include the wind load on the structure and live load cases, which have not been created yet. Also, check the “Include Buoyancy” box to automatically create a load case for buoyancy to consider buoyant effects on the pile group. After checking these boxes, the AASHTO tab should look like Figure 10.16.
Figure 10.16 Check Limit States and Include Buoyancy

Wind load on the structure and wind load on the live load cases can be automatically generated using the built-in “Wind Load Generator.” The user must provide the profile areas, wind pressures, and moment arms in order to compute the wind loads. The values are given in Figure 10.17 below.

Figure 10.17 Pier Area Profiles, Wind Pressures, and Moment Arms
To create wind loads, click the “Wind Load Generator” button. This example will consider three wind load cases: 1) 0 degrees, 2) 30 degrees, and 3) 60 degrees. Change the number of load cases to 3 and enter 0, 30, and 60 degrees for the wind angles. Enter the values shown in Figure 10.18.

![Wind Load Generation](image)

**Figure 10.18 Wind Load Generation**

The wind load is computed using the parameters specified. The resulting load is applied to the bearing locations. The vertical loads on the bearing locations resulting from the lateral wind loading are determined using the rigid beam formulation shown in Figure 10.18.

Click on the “Generate Wind Load Cases” button to create the three Wind Load on Structure and Wind Load on Live Load Cases. Click “Yes” when prompted to confirm the wind load generation and “OK” to acknowledge their creation. Click OK to save the changes and exit the dialog box.
The user can examine the wind load cases that were generated by clicking on the Load tab. The new cases can either be viewed by selecting a wind load case from the Load Case list or by clicking the Table button to view the AASHTO Load Table. Click the Table button. Expand the wind load cases to view the wind loads on the bearing locations as shown in Figure 10.19. The user can then apply additional nodal loads to the wind load cases if necessary. Click OK to close the dialog when done.

![AASHTO Load Table](image)

**Figure 10.19 Wind Loads in the AASHTO Load Table**

At this point all of the load cases have been created for this example. Click on the AASHTO tab to review the number of combinations. Notice that the Total Number of Load Combinations is now 13 after adding the wind load cases. The user should preview all of the load combination equations before running the analysis. This can be done by clicking the “Preview Load Combinations” button. Doing so brings up the window shown in **Figure 10.20**. Click OK to close the Load Combination Preview window. The user can continue to preview load combination scenarios after turning various limit states on and off.
This concludes the data entry for the example. Click on the Analysis button in the toolbar to analyze the pier under the specified load combinations. Note only the combinations of the load cases are considered in the analysis, not the individual load cases.

After successfully running the analysis, click on the “Pile Results” button in the toolbar. The Pile Results can be viewed by cycling through the load combinations at the top of the screen. The load combination equation is shown as the user cycles through the load. The maximum load combination for each limit state can be obtained by selecting an applicable Limit State in the Plot Display Control window.

Suppose that the user is interested in obtaining the maximum results for the EXTREME-II limit state. In this example problem, this limit state has two load combinations: one for the Live Load case 1 and one for Live Load case 2. Selecting EXTREME-II from the Maximum Combination combo box (Figure 10.21) will show the maximum load combination in the specified limit state and will automatically select the pile in which this occurs. The maximum is determined based on the largest demand/capacity ratio (if a full cross-section was specified) or the SRSS (Square Root of the Sum of the Squares) value of the axial force and moment combination (if a gross cross-section was specified). Also, click the checkboxes for the Member Forces and Soil Forces shown in Figure 10.21. Click “Apply” when done to update the graphs. The resulting plots are shown in Figure 10.22.
Figure 10.21 Selecting EXTREME-II Limit State

When viewing the results from a load combination, the load combination equation is shown at the top of the screen. When EXTREME-II was selected, the maximum result occurred in Load Combination 12. The corresponding load combination equation is shown in Figure 10.23. Notice that the first Live Load case (LL1) produced the maximum result.

Figure 10.22 Plots for Pile 3, Maximum Combination in EXTREME-II Limit State

Figure 10.23 Load Combination Equation for EXTREME-II Limit State
The user can also click on the up and down buttons to select any load combination for viewing the results. It’s important to note that these combination equations match the equations shown when previewing the load combinations before running the analysis.

The pier results can also be viewed in a similar manner. To do so, click on the Pier Results button in the toolbar. This time select STRENGTH-I from the list of available limit states. Click on both pier columns in the Pier Selection window. Make sure to check the box to plot the Demand/Capacity Ratio and then click Apply to update the plots. The resulting plots are shown in Figure 10.24. This figure shows that one of the pier columns is very close to capacity with a demand to capacity ratio of 0.874. The pier cap results and the maximum results from the remaining limit states can be shown in a similar manner.

Looking at the load combination equation at the top of the screen reveals that the maximum result occurred in Load Combination 2. Notice that the second Live Load case (LL2) produced the maximum result.

Interaction diagrams and the 3D displaced shape can be viewed as well.

Figure 10.24 Plots for Pier Columns, Maximum Combination in STRENGTH-I Limit State

Looking at the load combination equation at the top of the screen reveals that the maximum result occurred in Load Combination 2. Notice that the second Live Load case (LL2) produced the maximum result.

Interaction diagrams and the 3D displaced shape can be viewed as well.
Comparison of AASHTO LRFD Results to AASHTO Standard Specifications (LFD)

Before completing this example, it’s noteworthy to compare the results between the AASHTO LRFD and the Standard Specifications (LFD) codes. The FB-MultiPier program makes such a comparison rather straightforward by allowing the user to switch between the design codes. Recall that in the AASHTO tab in the Model Data window, the user must select the design code to use. When switching between design codes, FB-MultiPier attempts to convert the load case types between the codes. Any load cases that cannot be converted are removed.

Let’s reanalyze the problem using the AASHTO LFD code. Before proceeding, save the Example10.in file as Example10_LFD.in in order to preserve the results from the LRFD load combinations. After doing so, click on the Edit button in the toolbar to begin modifying the problem.

To change the AASHTO design code, click on the AASHTO tab and then click on the LFD option. The user will be prompted of any load case that could not be converted to an equivalent LFD load case. Note that the AASHTO Standard Specifications does not have a load type for vessel collision. AASHTO does however, prescribe a Vessel Collision Impact Force (P) in their Guide Specification and Commentary for Vessel Collision Design of Highway Bridges publication. The FB-MultiPier program includes the Vessel Collision Impact Force load type for modeling vessel impact events. Therefore, when switching from the LRFD code to the LFD code, the load type CV is converted to load type P. The reverse is also true when switching from LFD to LRFD.

The Vessel Collision load case is shown in Figure 10.25.
The Extreme event will be selected for comparison between the LRFD and Standard Specifications. Click the AASHTO tab and select GROUP VESSEL. This group is comparable to the EXTREME-II limit state in the LRFD code.

Click the analysis button to run the load combinations for the extreme event load cases. After successfully running the analysis, click on the Pile Results button in the toolbar. Select Group Vessel from the list of available groups and select the same plots to view as was done earlier in the example to view the maximum results for the load combinations in that group. Click Apply to update the plots. The resulting plots are shown in **Figure 10.26**.

Although not shown here, the pier results could also be compared. Other AASHTO groups could also be checked to determine the worst loading condition for the problem.
Figure 10.26 Plots for Pile 3, Maximum Combination in Group Vessel

This concludes Example 10.
11.  **MULTIPLE SOIL SETS**

Shown in Figure 11.1 is the bridge pier with geometry and soil conditions, which was modeled in Example 2. The problem represents a navigable waterway crossing, which involves both lateral and axial loads. The foundation consists of 6-54 inch drilled shafts (80 ft long), and two pier columns which are 30 ft tall, 5 ft square and spaced 16 ft apart. The pier cap is 4 ft thick and the drilled shaft cap is 10 ft thick with a 4.5 ft overhang. Due to localized and accelerated scour, the sand surface is located from 25 ft to 15 ft below mean sea level, and the soft rock is characterized as FHWA's intermediate geomaterial (IGM).

Because of fractures in the rock, two of the drilled shafts are embedded into a rock socket that begins 10 ft below the other sockets. These two shafts are also 10 ft longer. The properties of the sand and rock are given in Figure 11.1.
To begin, select Open from the File menu and choose the Example2.in file. The example problem is shown below in Figure 11.2. Before making any changes to this file, select Save As from the File menu to save the problem under a different name. Call this new file Example11.in.

![Figure 11.2 Example 10, Pier Structure](image)

Most of the work in this example involves creating soil sets to model the local scour condition and an additional pile set to model the deeper rock socket. The remaining model properties will be left as specified in Example 2 for later comparison of the results.

Each soil set can have a unique soil strata, including different soil layer elevations. Soil sets are ideal for modeling changes in the soil layers across a pile group. In the FB-MultiPier program, each soil set is connected to one of more piles/shafts and by default all piles/shafts belong to the first soil set. The current program limitation on the number of soil sets is 20.
This example problem will use three soil sets to model the local scour conditions. The first soil set will be used for the leftmost of row shafts, where the free standing length is 25 ft due to accelerated local scour. The second set will be used for the middle row of shafts where, the free standing length is 20 ft. The final soil set will be used to model the rightmost row of shafts, where is free standing length is 15 feet and the soft rock layer begins at a deeper elevation.

Soil sets are created and edited in the Soil tab. Click there now. The parameters for the first soil set are shown by default. In this example, the only value that needs to be changed is the Top of Layer Elevation. Change this value to -25ft to model the accelerated scour, as shown in Figure 11.3. Soil layers could be added, removed, and modified as well although it is not required in this example.

![Figure 11.3 Changing Top Layer Elevation to -25ft](image)

The Soil Set dropdown list currently shows “Set 1” and “Add Set.” Select “Add Set” to create the second soil set as shown in Figure 11.4. Click “OK” in the message box to confirm adding a new soil set. When a new soil set is added, all of the properties from the previous soil set are copied to the new soil set. In this example, only the Top of Layer Elevations needs to be changed for the second soil set. Enter -20ft as shown in Figure 11.5.
The Soil Set dropdown list currently shows “Set 1”, “Set 2”, and “Add Set.” Select “Add Set” again to create the third soil set. Click “OK” in the message box to confirm adding a new soil set. Change the Top of Layer Elevation to -15ft and the Bottom of Layer Elevation to -60ft to model the increasing depth of the sand layer. The elevation changes are shown in Figure 11.6.
The soil rock layer elevations also need to be adjusted. Select “Layer 2” from the Soil Layer dropdown list or click on the rock layer in the Soil Edit window. Change the Bottom of Layer Elevation to -100ft to model the deeper rock layer as shown in Figure 11.7.
The soil sets can be now be assigned to the shafts. Right click the mouse in the Pile Edit window to view the popup menu options. Select “Assign Soil Sets” from the menu. The Pile Edit window now shows the soil boundaries for each shaft (Figure 11.8). The boundaries are always set at half the distance between shafts. The number in each translucent soil block indicates the soil set for that pile. Although the values are not used in the analysis, missing piles are also assigned a soil set for 3D visualization purposes.

![Figure 11.8 Assigning Soil Sets](image)

Clicking inside a soil block increments the soil set number. The number cycles back to 1 when all of the soil sets have been viewed. Notice that each soil set is shown with a unique hatch pattern. For this example, click once on each soil block in the middle column of blocks to assign soil set 2. Click on each soil block twice in the fourth and fifth column of blocks to assigned soil set 3. When done, the Pile Edit window should look as shown in Figure 11.9. Notice also, that the 3D View window is automatically updated to show the application of the soil sets.
The second pile set can now be defined after creating all of the necessary soil sets. To do so, first click on the Pile & Cap tab and then click the “Edit Cross Section” button. In the Full Cross-Section Pile Properties dialog, click the “Add” button in the Pile Set Info section in the upper right hand corner. Once the new pile set has been added, enter 90ft for the Section Length as shown in Figure 11.10. The shaft in the second pile set will be used in conjunction with the deeper rock layer defined in soil set 3. Click OK to apply the changes and close the dialog box.

The final step in the model process is to assign the new pile set to the correct shafts. In this example, the last row of shafts will be modeled using pile set 2. Right click the mouse in the Pile Edit window and select “Pile Data/Batter.” Click on shaft 3. In the Pile Data dialog box, select “Set 2” from the Pile Set dropdown list as shown in Figure 11.11. Notice that the soil set can also be assigned in this dialog box. Next, click on shaft 6 and again select “Set 2” from the Pile Set Info dropdown list. Click “OK” when done. The Pile Edit window should now look like Figure 11.12, with a pattern to indicate the shafts that belong to the second pile set.
Figure 11.10 Creating Pile Set 2

Figure 11.11 Assign Pile Set 2 to Shaft 3
This concludes the model portion of the example. Click on the “Analyze” button in the toolbar to run the analysis with the new scour conditions. After the analysis converges to a solution, click on the Pile Result toolbar button. Select shaft 3 and the plot settings shown in Figure 11.13. Click “Apply” to update the plots.
Figure 11.13 Shaft 3 Results

For comparison, the results from Example 2 are shown in Figure 11.14. Notice that the demand/capacity ratio has increased from 0.802 to 0.899 due to the accelerated scour and deeper rock socket for shaft 3. Other conclusions can also be drawn.

This concludes Example 11.
12. PRELOADING AND APPLIED DISPLACEMENTS

Shown in Figure 12.1 is the default pile group problem that is loaded when creating a new Pile and Cap Only problem. The 2x2 pile group consists of 4 piles spaced at three pile diameters (3d). The weight of the pile cap will be applied equally to the four piles using the preload case. This load is meant to exist before any load cases are applied. The first load case is used to model a differential pile head settlement that occurs after the construction of the pile group due to a mischaracterization of the soil layer properties. The left row of piles settles 1.5 inches and the right row settles 1 inch. The goal of this example is to determine the effect of the settlement on the piles.

![Figure 12.1 2x2 Pile Group](image)

To begin, select New from the File menu, select Pile and Cap Only, and click OK. The default pile group problem is shown below in Figure 12.2. Most of the work in this example involves entering the load cases for the pile group. The remaining problem parameters will remain the same.
In this example, the preload case will be used to model the weight of the pile cap. Before applying the preload, it is important to explain the analytical technique used to model preloading. In the preloading phase, all of the loads in the preload case are applied to the undeformed model and the analysis proceeds until an equilibrium solution is obtained. If equilibrium is achieved, the first load case is then applied to the model, starting from the equilibrium position, and the analysis continues until convergence is reached. This means that the final converged result has load effects and displacements that are additive. The procedure is repeated for each load case. If convergence is not achieved in the preloading phase or during any load cases, the analysis ends.

Click on the Load tab and begin by deleting Load Case 2, since it will not be needed in this example. The preload case is not turned on by default. Click the “Include Preload” checkbox to turn on preloading. The preload case will start with a nodal load at Node 1, enter 20 kips for the Z Load. Add a Nodal load
for Node 2. This new nodal location will copy the load data from Node 1. Repeat to add loads for Nodes 2, 3, and 4. When done, the Load tab should look like Figure 12.3.

![Figure 12.3 Preload Case]

The settlement load case can now be created. Click on “Load Case 1” and delete the existing nodal loads. Click on Node 1 in the 3D View window (or select the Node# in the load tab using the up/down arrows). Click the right “Add” button to add a nodal load to Node 1. Next, click the “Applied Displacement” checkbox to indicate that this load is an applied displacement rather than a force. Enter 1.5 inches for the Z Load. Do the same for Node 3. Finally, apply 1 inch displacements to Node 2 and 4. This will create the differential settlement imposed in the example. When done the Load tab should look like Figure 12.4.
This completes the modeling phase of the example. Save this problem as Example12.in. Click the Analysis toolbar button to analyze the pile group under the given loads. After convergence is achieved, click on the Pile Results toolbar button to view the force results for the piles. Select Piles 1 and 2 in the Pile Selection window. Select the plot options shown in Figure 12.5 and click Apply to update the plots. Notice that the Demand/Capacity Ratio for Pile 1 is 0.772, indicating that the pile is load to 77\% of its capacity.
Figure 12.5 Pile Results After Settlement

Click on the 3D Results toolbar button to view the deformed shape of the pile group. There are two items to notice on this screen as shown in Figure 12.6. First, the effect of the differential settlement is pronounced and shows a rotated pile cap. Second, notice that the displacement at Node 1 is not exactly 2 inches. This is due to the fact that the preload displacement is added to the applied displacement (1.5 inches) to get the final displacement. If preloading was not used, the resulting pile head displacement would have been exactly 1.5 inches.
Figure 12.6 Deformed Shape of Pile Group After Settlement

This concludes Example 12.